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1) Document Organization and Objectives 
 

The document is divided in ###  sections:  

¶ Document Organization and Objectives : this section.  

¶ Roles & Responsibilities: roles, responsibilities, escalation path .  

¶ Pre - Requisites: requirements .  

¶ Introduction : overview of the technology .  

¶ Request Acess: steps required to request the necessary permissions to perform 

creation/updates of CSP sites.  

¶ Create a new CSP Site: steps required to create a new CSP site from the request of 

the creation of the URL till preview of the site created.  

¶ Know Issues/Trobleshooting: common issues, possible causes and solutions.  

¶ Appendix: Detailed information (document change history, reference 

documentation, etc. ).  

 

a)  Objective s:  

The current document il lustrates the steps required to  create a CSP basic site and all 

the necessary steps to request access to perform the tasks.  
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2) Roles & Responsabilities:  
(this section is dynamic and must be compoleted  according the project 
own resourses, escalations paths and type of issues/bugs that can 

happen)  

 

Approvers 

¶ Primary: Gustavo Mendoza (v-gumend@microsoft.com) 

¶ Secondary: XXXX 

 

 

Contact Name Email Phone Cell Phone Responsibilities 

MSC Manager      

Factory Lead      

CSP Users Helping  - csphelp@microsoft.com   

Users that provides 

help to users issues, 

questions,.. 

MSCOM Adoption 

Team - mscadopt@microsoft.com   Tool Adoption Team 

MSCOM Support 

Services  - mscomhlp@microsoft.com   

IT Team (Tech 

support) 

Microsoft.com 

Policy - mscomplc@microsoft.com   Policies Team 

mailto:v-gumend@microsoft.com
mailto:csphelp@microsoft.com
mailto:mscadopt@microsoft.com
mailto:mscomhlp@microsoft.com
mailto:mscomplc@microsoft.com
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a. Escalation Path (for issues during implementation): 

 

Issue Level Description 

Low 

Describe possible Issues/Bug (i.e.: the task 

has been delayed due to a holiday ) 

Medium Describe possible Issues/Bug 

Blocker Describe possible Issues/Bug 

 

Low Issue 

Time Line(After 

executioner 

informs) Level 

Contact To 

2 hour 6 

Infrastructure Crew (Email) 

with copy: Infrastructure Lead 

3 hour 5 

Infrastructure Crew (Phone or 

Communicator) 

4 hours 4 Infraestructura Lead (Email) 

6 hours 3 

Infrastructure Lead (Phone or 

Communicator) 
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>6 hours 2 

Project Lead (Email) with 

copy: Infrastructure Lead 

>8 hours 1 

MSC Manager (Email) with 

copy: Infrastructure and Project 

Leads 

  

 

   

Medium Issue 

Time Line(After 

executioner 

informs) Level 

Contact To 

30 minutes 6 

Infrastructure Crew (Email) 

with copy: Infrastructure Lead 

45 minutes 5 

Infrastructure Crew (Phone or 

Communicator) 

1,5 hours 4 Infraestructura Lead (Email) 

2 hours 3 

Infrastructure Lead (Phone or 

Communicator) 

3 hours 2 

Project Lead (Email) with 

copy: Infrastructure Lead 

5 hours 1 

MSC Manager (Email) with 

copy: Infrastructure and Project 

Leads 
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Blocker Issue 

Time Line(After 

executioner 

informs) Level 

Contact To 

10 minutes 6 

Infrastructure Crew (Email) 

with copy: Infrastructure Lead 

20 minutes 5 

Infrastructure Crew (Phone or 

Communicator) 

30 minutes 4 Infraestructura Lead (Email) 

35 minutes 3 

Infrastructure Lead (Phone or 

Communicator) 

60 minutes 2 

Project Lead (Email) with 

copy: Infrastructure Lead 

120 minutes 1 

MSC Manager (Email) with 

copy: Infrastructure and Project 

Leads 

 

bƻǘŜΥ ŀƭƭ ǘƘŜ ƛǎǎǳŜǎ ǘƘŀǘ ŀǊŜƴΩǘ ǇǊŜǎŜƴǘ ƛƴ ǘƘŜ ŘƻŎǳƳŜƴǘ ǿƛƭƭ ōŜ ŀǎǎƛƎƴŜŘ ŀǎ άaŜŘƛǳƳέ LǎǎǳŜ [ŜǾŜƭΦ 

 

 

 



 

     
Marketing Service Center   Infrastructure MSC 
 

9 

 

 

 

 

3) Pre-Requisites: 
In order to perform the steps of the following chapters you will need to fulfill the following 

requirements :  

¶ MS Alias  

¶ Corpnet Connection (RAS or direct Access)  

¶ MS Alias must be part of security group ñCSPCDevò (see section  Request 

Access) .  

¶ MS Alias must be part of the  ñCSPAdoptò distribution list  (see section Request 

Access) .  

¶ Request Access to the sites (see section Request Access).  

¶ Install the Content Selector ActiveX  control . 

 

 

4) Introduction  
The CSP technology itôs a group of services running on a SharePoint server that (the SP also 

has a defined data library and components structure) which grants the possibility to render 

complete web sites, this is possible by the configuration of InfoPathôs XML files inside the 

CSP ï SharePoint.  

 

The purpose of CSP is to divide the tasks  and responsibilities  of a developer, designer and 

site manager regarding the management of the webôs content. 

 

Tasks by role:  

¶ Designer & Developer:  the users with this role creates the components used to 

create the web sites such as the Master Pages with visual studio, InfoPath Templates 

(XSN files) called components and XMLT files that transforms the data filled on an 

InfoPathôs fill form in the HTML that the final user will see in the web site (this XML 

files are the fill form of the XSN templates).  

¶ Site Manager:  the users with this role will fill the InfoPath forms (XML) developed 

by the developer.  

file://tk3devngnsql01/CSP_Infopath/ActiveXControl/Microsoft.MSCOM.Authoring.ContentSelectorActiveX.msi
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5) Request Access 

 

a) Join to Security Group ȰCSPCDevȱ: 

i)  Description:  the addition of the user to the security group is 

needed in order to perform publish of components and advanced 
tasks over the CSP sites for develop, this role applies to Site 

Managers and Developers .  

ii)  Steps:  

(1)  Send an Email to Claudia Monteiro ( clmont @microsoft.com) requesting the 

addition of the user/s into the security group.  

 

b) Join to Distribution list  ȰCSPAdoptȱ: 

i.  Description:  Users on this group are notified by email every time 

that a new release is launch or a maintenance task is being 
performed.  

ii.  Steps:  

(2)  Send an Email to Claudia Monteiro ( clmont @microsoft.com) requesting the 

addition of the user/s into the group.  

 

c) Request Access to the Sites: 

i.  Description:  in order to perform the tasks users should be added 

manually to the CSP SharePoint site of the web that will be updated  
for both environments separated (PPE and Stage) .  

ii.  Steps:  

(1)  Send an Email to Claudia Monteiro ( clmont @microsoft.com) requesting the 

addition of the user  to the Site Ownerôs group for the environment needed.  

Note : if a MSC resource is already in the group he can add other users 

with the process described in the point ñAdding Users to the CSP Siteò (the 

users can be added in the environments separated).  

 

d) Adding Users to the CSP Sites: 

i.  Description:  if a MSC user is already in the Owners security group of a CSP 

Site then he can add his teammates to the group without requesting the task to 

MS (This process should be performed only on critical situations when 
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the center canôt reach the MS contact and in order to prioritize the 

exe cution of the task) .  

ii.  Steps:  

(1)  Go to the CSP Site of the web.  

(2)  Click ñSite Actionsò. 

(3)  Click on ñSite Permissionsò 

(4)  Click on the Site Owner Group (it begins with the name of the site and ends 

with the text ñOwnerò). 

(5)  Click on ñNew\Add Userò 

(6)  Insert the email of the  user and click on save . 

 

 

6) Creating a New CSP Site 
In this step user will be instructed to create a new CSP Site (Basic ñHello worldò site) on the 

PPE environment.  

 

a) Request the creation of a CSP Environment: 

i)  Description:  the first step in the creation of a  CSP site in the 

creation of the PPE and Stage environments , this process is performed 

by the MS MSCOM team.  

ii)  Steps:  

(1)  Crear un Security Group dedicado para el sitio  

(a)  El nombre del SG en idweb  debe ser tener la siguiente estructu ra por 

ejemplo ES -AR_aulavirtual_RW. ñESò es por el lenguaje, ñARò pa²s al que 

pertenece el sitio, ñaulavirtualò url del sitio dentro del dominio por ej. este 

sitio será www.microsoft.com/es - ar/aul avirtual  y RW es un 

parámetro fijo. Cuando se crea se debe poner como miembros a todos los 

Site Managers y a todo el equipo de desarrollo. Los owners deben ser para 

latam: Craig Webster, Ezequiel Sapoznik y el líder de la fábrica de SM. 

Como Owner Visible debe ser Craig Webster, el resto de las 

configuraciones deben estar por default.  

(2)  Request a root level site:  

(a)  Solicitar el root level en 

http://sharepoint/sites/MSCOM/Lists/New%20root%20site%20r

equest/AllItems.aspx  

https://idweb/
http://www.microsoft.com/es-ar/aulavirtual
http://sharepoint/sites/MSCOM/Lists/New%20root%20site%20request/AllItems.aspx
http://sharepoint/sites/MSCOM/Lists/New%20root%20site%20request/AllItems.aspx
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En el menú superior ir a List Tools -> Item -> New Item y completarlo de 

la siguiente manera  y grabar.  

 

 

(b)  Luego llegara un varios mails aclarando que se esta creando el pedido y el 

último mail llegaran las rutas de stanging y ppe para el sitio.  

 

(3)  Request a CSP Top -Level Site:  

(a)  Once your root level site is created, you must request a CSP top - level site 

by complet ing the  CSP site creation request form .  

(b)  En el menú superior ir a List Tools -> Item -> New Item y completarlo de 

la siguiente manera  y grabar.  

 

http://sharepoint/sites/MSCOM/Lists/CSP%20Top%20Level%20Site%20Request%20Form/AllItems.aspx
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(c)  Luego llegara un varios mails aclarando que se esta creando el pedido y el 

último mail llegaran las rutas de cspauthoring y cspautoringppe para el 

sitio.  

(d)  Estos ambientes se crean todos los días lunes.  El proceso entero de crear 

el root y el cspauthoring pu ede llevar entre 10 y 15 días.  

(4)  Activar el root level para la publicación.  

(a) Para publicar hay que copiar dentro de la carpeta root, por ej.: 

\ \wwwstaging\drop\ locale\es-ar\aulavirtual  estos 4 archivos: 

(i) Default.asxp, Default.geo, Global.asax  y  web.config  

Estos archivos pueden  encontrarlos en este link. 

(5)  Activate CSP Site Features (on both environemtns, PPE & Stage):  

(a)  Go to your CSP Sharepoint Sites.  

(b)  Click on ñSite Actionsò. 

(c)  Click on ñSite Settingsò. 

 

(d)  Click on ñManage Site Featuresò. 

file://wwwstaging/drop/locale/es-ar/aulavirtual
http://sharepoint/sites/MSCteam/Intrastructure/InfrastructureWorkspace/Project%20Documents/Forms/AllItems.aspx?RootFolder=%2Fsites%2FMSCteam%2FIntrastructure%2FInfrastructureWorkspace%2FProject%20Documents%2FDigital%20Hub%2FSiteManager%2F03_CMS%20Onboarding%20Documents%20-%20Final%20version%2FCSP%20Root%20files&InitialTabId=Ribbon%2EDocument&VisibilityContext=WSSTabPersistence
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(e)  Activate the following MSCOM Features by clicking the activate  Button 

next to each.  

(i)  Obligatorios:  

1.  MSCOM Authoring Libraries  

2.  MSCOM Authoring Query Lists  

3.  MSCOM Bulk Content Management  

4.  MSCOM Private Serialization Packages  

(ii)  Optativos  

1.  MSCOM Remove Internal Link Checking  (Solo para emergencias, no 

chequea las dependencias en la publicación)  

2.  MSCOM Rendering Libraries (Solo para desarrollo de nuevas 

masters o componentes  

 

 

 

(6)  Setup Content types for your libraries:  

(a)  Click on ñSite Actionsò. 
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(b)  Click on ñSite Settingsò. 

(c)  Click on  ñSite libraries and listsò. 

 

(d)  Click on ñCustomize Componentsò 

 

(e)  Click on ñAdd from existing site content typesò (this is to add the 

components that the site managers will use to setup the website).  
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(f)  In the list labeled Available Site Content Types: select oneMscomBlade, 

oneMscomContent, oneMscomFooter, oneMscomNav and oneMscomSearch  

then click on Add  (if the components arenôt displayed is because the same 

are already in the Content Type list but if fo r any circumstance the same 

arenôt displayed on any place then contact the MSCOm Adoption Team). 

Note :  You can use whatever content controls you 

prefer.  We simply recommend oneMscomContent as a 

good candidate for use.  

 

(g)  Clink on ñOKò button. 

(h)  Click on ñSite Actionsò 

(i)  Click on ñSite Settingsò. 

(j)  Click on ñSite Libraries and Listsò. 

(k)  Click on ñCustomize Rendering Assetsò. 
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(l)  In the Content Types section, click ñAdd from existing site content types ò. 

 

(m)  In the Content Types section, click ñAdd from existing site content 

types ò. 

(n)  In the list labeled Available Site Content Types: select oneMscomNavData, 

oneMscomSiteSettings, and oneMscomSiteLocales then click Add.  (This  

will add the components to be used by the site manager).  
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(o)  Click ñOKò button. 

(7)  Setup Template Definition For Layouts:  

Note : You can use whatever page layout you prefer.  We 

simply recommend alHome.xml as a good candidate for use.  

(a)  Click on ñSite Actionsò. 

(b)  Click on ñView All Site Content ò. 

 

(c)  On the list section click on ñTemplate Definitionsò. 
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(d)  Click on ñAdd New Itemò. 

Note : If you copy file, component and attribute names 

from this Word document and then paste them into an 

InfoPath form, ensure that there are no trailing spaces 

at the end of the pasted text.  

(e)  Enter alHomePageLayout in the Title fi eld.  

(f)  Enter /about/legal/TemplateLib/alHome.xml in the Template Location 

field.  

(g)  Select page in the Applicable Template Types section and then click Add . 

 

(h)  Click ñSaveò Button. 

 

 

(8)  Create Component XML Files:  

(a)  Click Components in the Libraries list on the far left of the page.  

(b)  Select the Documents tab . 
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(c)  Click the down arrow to the right of the New Document icon.  

(d)  Click ñoneMscomBlade ò. 

 

Note : When completing the steps in this section that 

require you to open an InfoPath form, you may be 

prompted with dialog boxes that present Security 

Warnings.  If these appear click Open each time.  You 

may also be prompted to supply your smart card.  You 

do n ot have to insert a smart card to complete this 

work.  If the smart card dialog boxes appear, click 

Cancel.  
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Warning :  Do not make any changes to the InfoPath 

form.  

(e)  On the File menu of the InfoPath form, select Save as, and enter 

oneMscomBlade for the name o f your form and click Save.  

Note : Be sure to use the exact capitalization specified in 

these instructions.  In some case that capitalization may 

differ from the name displayed inside the InfoPath form 

itself.  

(f)  Close Infopath Form.  

(g)  Repeat steps d ï f for each of the following components (using the name 

of that specific component for the File name each time):  

(i)  oneMscomContent  

(ii)  oneMscomFooter  

(iii)  oneMscomNav  

(iv)  oneMscomSearch  

 

 

(9)  Create Sample Content:  

Note :  You can use whatever content controls you 

prefer.  We simply recommend oneMscomContent as a 

good candidate for use.  

(a)  Click Components in the Libraries list on the far left of the page.  

(b)  Click oneMscomContent.  

(c)  Open a Word document and type ñHello Worldò. 

(d)  Copy and paste the text from your Word document in the Rich Text 

section (this is for the body of your site).  

Warning : DO NOT type directly in the Rich text box . 

(e)  Click Save on the File menu.  

(f)  Close the InfoPath form.  
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(10)  Check In All Components:  

(a)  Click Components in the Libraries list on the far left of the page . 

(b)  Check in oneMscomBlade by pointing to the component, clicking the drop -

down arrow that is next to the file name and selecting Check In.  

  

(c)  In ñwhat  kind of version would you like to check in? ò Control , select #.# 

Major version (publish) . 

 

(d)  Click ñOKò Button. 

(e)  Repeat steps b ï d for the remaining components.  

(f)  When you are finished all five of your components should have their 

Approval Status set to Pending.  

 

(g)  Use the standard publishing rules at 

http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing -

dependency - checking.aspx  to publish your changes.  

http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing-dependency-checking.aspx
http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing-dependency-checking.aspx
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(11)  Create Rendering Assets XML Files:  

(a)  Click Rendering  Assets in the Libraries list on the far left of the page.  

(b)  Select the Documents tab.  

 

(c)  Click the down arrow to the right of the New Document icon.  

(d)  Click ñoneMscomNavData ò. 
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Note : When completing the steps in this section that 

require you to open an InfoPath form, you may be 

prompted with dialog boxes that present Security 

Warnings.  If these appear click Open each time.  You 

may also be prompted to supply your smart card.  You 

do not have to insert a smart card to complete this 

work.  If the smart card dialog boxes appear, click 

Cancel.  

(e)  Inside the form enter Level 1 Sample in the TITLE field . 

(f)  Click ñInsert URLò. 

(g)  Enter http://office.microsoft.com  in the URL field.  

(h)  On the File menu of the InfoPath form, select Save as, and enter 

oneMscomNavData for the name of your form and click Save.  

Note : Be sure to use the exact capitalization specified in 

these instructions.  In some  case that capitalization may 

differ from the name displayed inside the InfoPath form 

itself.  

(i)  Close the InfoPath form.  

(j)  Check in oneMscomNavData by pointing to the rendering asset, clicking 

the drop -down arrow that is next to the file name and selecting  Check In.  

http://office.microsoft.com/
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(k)  In the What kind of version would you like to check in? control, select #.#  

Major version (publish) . 

(l)  Click ñOKò Button. 

(m)  Use the standard publishing rules at 

http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing -

dependency - checking.aspx  to publish your changes.  

Note : If you are setting up a new secondary site yo u 

will not complete steps 14 -33 below.  However, you will 

need to contact the owner of your primary site to have 

them add an entry in the master copy of 

oneMscomsiteLocales.xml for your new locale specific 

site.  

 

Warning  ï Critical Information : Only 

perform steps o - gg  if you are a primary site.   

Otherwise, skip to step hh . If you are setting up a 

primary site you MUST complete the steps in this 

section.  

(n)  Click the down arrow to the right of the New Document icon.  

(o)  Click ñoneMscomSiteLocalesò. 

(p)  Insi de the File menu of the InfoPath form, select Save as, and enter 

oneMscomSiteLocales for the name of your form and click Save.  

(q)  Close the InfoPath Form.  

(r)  Click oneMscomSiteLocales to open the InfoPath form again.  

(s)  In the Name field under Sub enter the name of  your first subsidiary (A sub 

usually represents a country.  Locales are then defined within those subs 

(one for each language used in that Sub).  

http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing-dependency-checking.aspx
http://sharepoint/sites/MSCOM/SitePages/CSP/CSPpublishing-dependency-checking.aspx
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(t)  Inside the form click ñInsert Localeò. 

 

(u)  In the Name field under the first Locale section enter the country code for 

your first locale.  

(v)  Choose the appropriate Text direction.  

(w)  In the Text field enter the text that you want to be displayed in the locale 

picker control that will be part of the blade.  

(x)  In the URL field enter the URL of the home page for this site in that locale.  

(y)  If appropriate enter the same information for the second Locale in that 

sub  (or delete the second Locale by using the arrow control that appears 

to the left of Locale an thenm selecting Remove locale).  

 

(z)  If appropriate, add a second Sub by clicking Insert Sub . 

(aa)  Continue adding Subs and Locales until you have an entry for each 

locale in which your site  exists .  










































